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If You Don't Read Manuals...

Start playing! If you don't understand something, refer to the
built-in help system. To gain insight into possible strategies,
read the Strategy Hints section.

Minimum Requirements

Darwin’s Dilemma 2.0 will run on all Macs from the Plus on
up including PowerBooks. It is fully System 7.0 compatible.
You do not need a hard drive to run Darwin’s Dilemma. If
you do have a hard drive, installing Darwin’s Dilemma is
easy: simply drag the application onto your hard drive.
Darwin’s Dilemma is not copy-protected.

Darwin’s Dilemma contains lots of great sounds. To hear
them, you need System version 6.0.1 or higher. If you are
using an earlier version of the System software, you will not
hear any sound as you play.,

Getting Started

Darwin’s Dilemma 2.0 includes the original game, or Standard
World, plus an option to create your own games using the
built-in editors. You can create your own icons and levels
thus an entirely different game, or as we call it, World.

When you launch the game you will find the opening dialog.

DARWIN'S DILEMMA

THE SOLUTION IS EVOLUTION
Current World: Standard World

[ Play ]

( Load worla |

[ Editor ]
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If you simply wish to play the original game press the Play
button. If you want to load another World that you have cre-
ated and saved to disk, press World.

Or, you can go right into the level and icon editors by press-
ing the Editor button. We supply you with a Sample World to
get you started.

Overview

Darwin’s Dilemma begins with a variety of icons, represent-
ing various life forms, randomly distributed on a board. You
must move these icons horizontally and vertically, forcing
them to collide with other icons. When two identical icons
meet they merge into one. If you merge the correct number
of identical icons together, they evolve into a new icon.
Evolve enough icons on one level and the next level appears
with a new assortment of icons. You gain points for merging,
evolving, and moving to the next level.

Darwin’s Dilemma is a strategy game. Successful play
depends on planning ahead! Luck also plays a significant role
in the difficulty of each level.

Controlling the Icons

In this section, we will explain the basic mechanics of mov-
ing the life form icons using the control piece, which we call
Darwin. To move an icon, you must place Darwin on the cor-
rect side of the icon and then use him to kick the icon.

Moving Darwin

The first step in moving a life form icon is to position
Darwin, the control piece. Darwin is the only icon that
you can maneuver directly, He can move anywhere on
the board that is not t()l.illv blocked by other icons.
You move Darwin with the mouse.

Darwin's Dilemma 5



Click on an empty spot; Darwin will move there. He also
“wraps around”; he will slide off one side of the board and
reappear on the other. In the illustration below, for example,
if you click on the spot marked by the X, Darwin will move
off the right end of the board and reappear on the left.

X

»

&R
R
R

&
&

Darwin always kicks an icon away from himself, so to move
an icon to the right, for example, you must put Darwin on
the left side of the icon. In the illustration below, Darwin is
poised to kick the whale to the right.
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Kicking Icons

Now that Darwin is positioned next to an icon, all you need
to do is kick the icon. The icon will then be kicked in a
straight line (up, down, left, or right) away from Darwin.

Place Darwin next to the life-form icon that you want to

move. Click on the icon. The icon will be kicked away from
Darwin.
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Wrapping Around the Board

You have already seen that Darwin wraps around the board.
Icons also wrap around. For example, in the diagram below
Darwin is in position to kick the whale to the right. When
kicked, the whale will move past the edge of the board on
the right, reappear on the left, and continue on its journey.

Darwin's Dilemma



Collisions, Merging & Evolving

When you kick an icon it moves in a straight line until it hits
something else. Planning this collision is the essence of play-
ing Darwin’s Dilemma. There are three different types of col-
lisions you will encounter: those involving two identical
icons, two dissimilar icons, and an icon and Darwin.

Dissimilar Icons

When an icon hits a different type of icon, it stops. If you
kick the whale icon to the right...

Darwin's Dilemma 9



Evolution Help Screen

Under the Help menu at each level you will find the
Evolution Help Screen. This is a chart of the necessary evolu-
tions you must make to complete the level.

Evolution Rules - Level | Daaaeee—e—e—|

=0

In the example above, the icon at the top is the goal. Each of
the other icons shows how many of that icon you must
merge together to evolve into the icon above it. You will find
it helpful to refer to this chart when you start a new level. If
you have a large screen, you can move this window so that
you can use it for reference.

Swapping

If you are stuck, Darwin's Dilemma allows you to move an
icon to any spot on the board by using a built-in cheating
technique known as the Swap. Simply place Darwin where
you would like the icon to be and double-click the icon. The
icon and Darwin will switch places. Unfortunately, you are
allowed only a limited number of Swaps at each level, and
each Swap will cost you 40 points. To undo a Swap, simply
select Undo from the Edit menu.

12 Darwin’s Dilemma



At the beginning of the game (Level 1) you are given eight
Swaps. You earn two more with every level you complete.
Remember that you lose 40 points when you Swap.

You can learn more about using Swaps wisely in the Strategy
Hints section.

Multiplicity

Let's say that one level of Darwin’s Dilemma contains 12 A

icons, which must be merged to make three B icons. So,
exactly four A icons are needed to make one B icon.

B B B
AR AR AR

Also assume that you have merged three As into one A icon
(value of three) and two A icons into one (value of two), as
seen below.

A3/4 AZ/4

(The “3/4” means that three icons have been merged together
and that four are needed to evolve). If you were to merge
these two icons together, they will evolve into a B icon, but
you will have used five icons to evolve instead of four. That
extra A icon was needed to merge with three others, so you
would find yourself one icon short, and unable to complete
the level.

To avoid such problems of multiplicity, study the Evolution
Help Screen and compare it to the number of icons on the
board. And, as always, proceed with care.
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The Menus

File New Game, Open, Save, Save As,

and Quit (and their standard
New Game %N Command key equivalents) work

End Game in Darwin's Dilemma exactly as
Go to Fditor %6 they do in every other Macintosh
program. Since Darwin’s

Dilemma saves games in a sepa-

Open... *0 rate file, you can have as many

saved games as vou want at one

Save 8S time (but you may not have more
save As... than one game open at once.)

Note that the menus are differ-

Quit 0 ent when you are in the editor.

Selecting End Game ends the current game and brings you
back to the opening dialog allowing you to go to the editor
or simply load a different world.

DARWINS DILEMMA

THE SOLUTION IS EVOLUTION

Current World: Standard World

[ Play ]

([ Loadworia |

[ Editor |

Go to Editor brings up a dialog box allowing you to select the
world you wish to edit. The Standard World is fixed and can-
not be edited. This is so that you can fairly compare high
scores with other players.
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Selecting the Undo item
(Command-Z) removes the

Undo #Z | last move you made.

Darwin’s Dilemma allows you
T ¢ ®} | to continue to undo moves,
£ opy w | UP tq the 120 la:j;l mo_'ves ?*ou
Bpats w1l made at each level. .(‘mu can-
=i i not return to a previous level,
Livar however.)

You will not need Cut, Copy, Paste, and Clear to play
Darwin’s Dilemma. However, we have provided them for you
to use with your Desk Accessories.

m Darwin’s Dilemma contains a

lot of sounds. If you (or
‘/s‘?unds *B someone in the room with
High Scores &K you) would prefer not to hear
them, simply make sure that

Hide! %€H Sounds is not checked.

High Scores brings up the high score screen.

Hide! puts your Mac into screen saver mode. This is handy if
you are playing at work and you have created a world where
your boss evolves into pond scum.

= There are three different top-
General 3®7 ics under the Help menu:
Evolution 3E General, Evolution, and

Scoring 3J Scoring.

If you select the first, General, you will receive information
about the basic operation of the game.

Selecting Evolution will bring up the Evolution Help Screen,
explained on page 15.

The Scoring screen lists the points lost and gained for each
move.
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The Level and Icon Editors

Darwin’s Dilemma 2.0 allows you total control! Say, for exam-
ple, vou would like a world where vour boss evolves into
pond scum... it's possible with the Darwin’s 2.0 editor!

To enter the editor from the opening screen, click the Editor
button. From inside the game, choose Go to Editor from the
File menu, or use Command-G. A dialog box appears.
Choose the world that you would like to modify.

| €3 Darwin's Dilemma 2.0 ¥ |

0 Sample World > > Sharon

|
g [ Cancel ]

Note: You cannot edit the Standard World. This is so that you
can compare scores with your friends and be certain that you
are playing the same game. However, we have included a
Sample World on the disk to get you started.

The Level Editor

The Window title shows the name of the World that you are
editing and the level that you are editing. For example
“Sample World - Level 1”7 shows that you are editing level 1
of the world called “Sample World.”

A large part of the window is taken up by a tree chart that
shows the evolution rules for that level. Evolution moves
upward, that is, the lower icons evolve into the icons above
them.
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Sample World - Level 1

Fogd
Ao

e AT Y s

- 5] e

Level The Level menu in the editor

NeRr{ Lpupl = | 1S how you control the differ-

CEBTRES LB e g ent features of the level editor.

New Level creates the next
New Level level.

Delete Level...
Move Level...
Check Level...

Delete Level... allows you to
delete the current level.

Move Level... allows you to
New Top lcon move the current level.

Check Level... is a safety fea-
ture. If the level is not solvable you will be warned and given
a chance to fix it.

New Top Icon lets you add another branch to the current
level.

Darwin's Dilemmea 17



The File menu changes when
you are in the editor. Save
Save Changes S Changes will save any changes
Import Icons... you have made to the current
World.

Exit Editor %0

Import Icons... allows you to
import icons from other applica-
tions and is discussed further on page 22.

Exit Editor takes you back to the game.

Changing the number of icons

Most of the icons are marked with the number of icons that
need to be merged to form the next highest life form. For
example “needs 2" indicates that two of this icon must be
merged to form the icon immediately above it. At the top of
each level, you will see an icon marked “Next Level.” This
means that when this icon is formed, the player moves to the
next level. The icon that appears at the top of the final level
is marked “*Wins*.” This is the final icon of the game.

Needs:

Start: |4

( Delete ] [ cancel |

It is easy to change the number of icons that must be merged
to create the next icon. Click on any icon that is labeled
“needs.” A dialog box appears. You can enter new numbers
for Needs and Start. Needs is the number of icons that must
be merged to create the next icon in the evolutionary tree.
Start is the number of icons that appear when the level
opens.
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Changing the Evolution order

It is also easy to change the evolution order. Click on any
icon at the bottom of the screen. Drag this icon over the icon
you would like to replace. You will see the icon change to
show your modifications. You can also add to the evolution
tree by dragging an icon from the bottom of the screen to
one of the empty spots on the tree (indicated by an empty
dotted square.) A dialog box will appear. If this new icon is a
bottom level icon (that is, one that is not created by the
merging of any lower icons) be sure that you enter a number
in the Start field. Otherwise, the new icon will not appear in
the game.

What if you don't have all the icons you need to create the
world you envision? You can use the icon editor to duplicate
any of the available icons by copying and pasting it into a
new icon window where it can be modified. You can create a
new icon from scratch or import icons from Darwin’s worlds
or other applications.

Editing Icons

At the bottom of the screen, to the right of the row of icons,
you will see three buttons: Edit Icon, New Icon, Delete Icon.

Edit Icon
e Click on any icon at the bottom of the screen.
 Click on the Edit Icon button
¢ The Icon Editor appears
e Note: Double-clicking on any icon also brings up the icon
editor.

New Icon

e The icon editor appears allowing you to create your own
from scratch.
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Delete Icon

e Click on the icon that you would like to delete at the bot-
tom of the screen.

e Click on the Delete Icon button.

* A dialog box will appear asking if you really want to delete
the icon.

The Icon Editor

If you have edited icons in ResEdit or another editor, the
Darwin’s Dilemma Icon Editor should look very familiar. The
center of the window contains an enlarged (“Fat Bits”) ver-
sion of the icon that you are editing. On the right you will
see four paint tools: a pencil tool, an eraser, an eye dropper,
and a paint bucket.

lcon Editor ©

B&W lcon

Color lcon

&3]

Color Mask
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The Paint Tools

The paint tools work just as the same tools in any Macintosh
paint program. Click on a tool to choose it. Move your cursor
over the large picture of the icon in the center of the Editor.
You will notice that the cursor changes to show which tool
you dare using, so that if you are using the pencil tool, the
cursor will look like a pencil. Now click somewhere in the
picture.

The pencil tool will draw one pixel at a time. If you are work-
ing in color, click to choose a color from the palette at the
bottom of the window.

The eraser tool erases (turns to white) any part of the picture
that it touches when clicked or dragged.

If you click the eyedropper tool on the icon, it will make the
color it touches the active color.

Use the paint bucket tool to dump a color (or black, in black
and white) onto a large section of the icon.

If you make a mistake while you are using the paint tools,
simply select Undo from the Edit menu, or type Command-Z,

Below the paint tools, you will see the icon you are editing
in its actual size.

The Mask
On the left you will see the black and white version of the
icon, the color version of the icon, and the icon’s mask.
When Darwin's Dilemma draws an icon on the screen, it first
uses the icon’s mask to erase part of the background, and
then draws the icon on top of the mask. The mask is generat-
ed automatically, but you ¢an modify it with the paint tools.
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Importing Icons

If you have icons stored in a HyperCard stack, for instance,
or in another Darwin’s World, you can import them into the
world you are currently moditying. Choose Import Icons. ..
from the File menu. A dialog box will appear. Open the file
that contains the icons vou would like to import. A new dia-
log box will appear that contains a row of icons. Select the
icons you would like to import. If you would like to choose
more than one, simply hold down the Shift key. You will
then be able to chose as many as you like.

Icons in "Swamp Gas™"

Please select the
icons to import:

< EfE

=

Cancel fmpprd

When you have chosen all the icons that you would like to
import, click the Import! button. In a4 moment, you'll see
these new icons at the bottom of the level editor.

Leaving the Editor

Select Exit Editor from the File menu, or type Command-Q to
return to the game.

I
b
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Strategy Hints

PLAN AHEAD! This is the most important strategy of Darwin's
Dilemma. If you think ahead, you will avoid two major prob-
lems: clusters and misused Swaps.

Avoid Clusters

A cluster is a group of icons stuck together so that no icon in
the group can be pushed. Two typical clusters, one with four
icons and one with six, are seen in the illustration below,

Since it is impossible to push any of the clustered icons, you
must use at least one Swap to break up the clusters.

Use Swaps Wisely

Sometimes you will need to Swap once or twice to complete
a level. If you find that you have used up all your Swaps and
you still haven’'t completed the level, you probably did not
create an overall plan of action when you started the level. If
you study each level carefully before you move you can
avoid overusing Swaps.
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Strategy Example One: Using Swaps Wisely

This section contains two possible solutions to a sample
board configuration. The first solution demonstrates how to
use one carefully chosen Swap where more than one might
seem necessary. In the second solution, you will see that the
same problem can be solved without using any Swaps at all.

The evolution rules for this example: two As merge and

evolve into a B, two Bs make a C and four Cs evolve into the
creature that takes you to the next level.

Solution One — A Single Swap

MER
AR Y V|
c2: iB1:Ct

This is the initial board position for this problem. A smart
move would be to Swap A2 one square up and to the left (as
shown by the arrow.) This aligns A1 and A2 with each other,
and with B1. Since Al and A2, when merged, will evolve into
a B, this is the beginning of a good plan.
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..............................................................

..............................................................

...............................................................

.............................................................

A1l has now been pushed left into A2, and the two icons have
merged and evolved into B2. Since the two Bs are now in
line, now take care of the Cs. C3 can be pushed left, and it
will wrap around...

D A o o o ol e

..............................................................

.............................................................

..............................................................

...and stop when it hits B2. All the Cs are now in line, either
vertically or horizontally. From here it is simple to complete
this level. Push C2 left and it will wrap around and merge
with C1. Push B2 down to merge with Bl and it will evolve
into C4. Push C4 right and C3 down, to complete the level.

Darwin's Dilemma
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Solution Two — No Swaps
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Starting with the same initial board position as Solution #1
above, move C1 down, to wrap around and hit the top of A2,
then left, to merge with C3. This maneuver clears the way for
B1 to slide right.

: A
1§ L AT
....................
. ) “ ‘

- A2 *
.....................
. :
.....................

€2: Bl
...................................

Push B1 right, to hit C2 from the left, then up to stop below
Gl
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C1 and Bl now act as blocks so that Al and A2 can be

pushed left, where they will be in line with each other.

...............................................................

L b i o i i B L e IR E R N i ST i e g e g U e B e b W

................................................................

Merge the As by pushing Al down. They evolve into B2. C2
is then pushed down so that it wraps around the top and hits

B2.

Darwin's Dilenima
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From this point it is simple to complete the level, and with
the knowledge that not a single Swap was wasted!

Strategy Example Two: Breaking Up Clusters
Breaking up clusters requires judicious use of Swaps. If you
find a cluster on the board, don't panic! One carefully

planned Swap may be all that you need.

For this example, let us assume that the As evolve into Bs.

| Az Y3
........ e Y4 Z'm
Y2 z4 Y! 22
- 3 o

On the initial board position no icon can be moved with
Darwin, so you must Swap. There are (roughly) 336 different
Swapping moves you could make, but with experience you
will know where to look. Consider Swapping Al to the
square marked by a dot.
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Z1 moves right to merge with Z3. A2 slides up to merge with
Al and evolves into B2.

: v3
........ ZIY4 ol
........ S g e
,,,,,,,,, xaaz

B2 is now in position to be combined with the other B. Push
Z2 upwards then right so that it can merge with Z1, Then Y1
is pushed right to merge with Y2.
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Having busted one cluster you are ready to attack the other.

Towards a Higher Score

There are many opportunities throughout Darwin’s Dilemma
to gain extra points. For those of you aiming for the highest
possible score, here is an example. Note that the following
example assumes that this level has spare icons, i.e. that
there are more icons on the board than are necessary to com-
plete the level. (A number of the levels in Darwin’s Dilemma
contain these extra icons.)

For this example, assume that As evolve into Bs.

s eaas B e EEEEEEEES

....................

Teleirwap

......................

.........................................................

...........................................................

.......................................................
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The two Bs could be merged right away to get to the next
level, and you would score 50 points. If you take care of the
As first, however, you'll gain more points, even though you
have to Swap! Here’s how...

Action Points
Swap (as shown) to align the As —40
Merge the two As to evolve into a B +30
Merge the new B with B (1/4) +20
Merge the remaining Bs to the next level +50
Final Score (instead of 50) +60

This gives you an additional 10 points.
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